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INTRODUCTION TO THE TEACHER GUIDE

A perfect guide for an ICT teacher is one that provides support to the teacher to engage the students 
in joyful learning. Information and Communication Technologies (ICTs) refer to the possibilities 
offered by the convergence of data processing techniques, electronic media, and telecommunications, 
a convergence that has become evident over the past few years. 
 ICTs are grouped under two categories: traditional and new. Traditional ICTs are radio, television, 
and fixed line telephones etc., which have been gradually ingrained in the daily habits and lives of 
people and communities. New ICTs consist of computers and specific data processing applications 
accessible through those computers (e-mail, Internet, Word processing, and other data processing 
applications). 
 New ICTs are now found on the development agenda of African countries like Ethiopia, and 
strategies have been gradually implemented to integrate them into the development process. Many 
countries have initiated significant reforms in the telecommunications sector: privatizing companies, 
liberalizing and ending national monopolies in this sector. 
 This Teacher Guide will help the teachers to:
  explain how Information and Communication Technology (ICT) has the potential to make a real 

improvement to teaching and learning in schools.
  demonstrate a wide variety of ways in which ICT can be used to enhance learning, offering a 

fresh burst of inspiration for them i.e., the busy school teachers.
  take a structured approach, ensuring that the students can be guided progressively through all 

the contents in order to achieve the required standards for achieving Qualified Teacher Status, 
and also to continue their development in ICT to an advanced level. 

  analyze all the common ICT tools and explain how they can exploit these tools for effective 
learning.

  explore how students can learn with ICT, how their skills develop, and how these skills can aid 
their learning.

  provide a framework for planning, analyzing and evaluating teaching with ICT.
  use Internet, educational trips and other aids to support class room teaching.
  prepare additional activities and assessments for the students.
  offer a range of innovative tasks, resources and methods of assessment.
  use key ideas, skills and techniques of ICT in other curriculum areas.
 The guide also provides websites that have additional content for the teacher. 
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INFORMATION 
SYSTEMS

(15 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l understand the concept of E-learning, E-commerce, E-government, E-banking and E-libraries.

suGGested lesson plAn

Sub-units
Number of 

Periods

1.1 Basic of E-Learning 3

1.2 Basics of E-Government 4

1.3 Basics of E-Banking 2

1.4 Basics of E-Libraries 2

1.5 Basics of E-Commerce 2

1.6 System Analysis 2

stRuCtuRe of the unit

1.1 Basics of E-Learning

In this sub-unit, we will learn about basics of e-learning. 
The topics to be learnt are:
 l Define electronic learning
 l Advantages and disadvantages of e-learning
 l Technology necessary for e-learning
  Information technology
  Telecommunication technology
  Internet connection

 l How e-learning works?

1.2 Basics of E-Government

In this sub-unit, we will learn about basics of 
e-government.
 The topics to be learnt are:

unit 1   

 l Definition of e-government
 l Advantage of e-government
 l Application of e-government
 l Services delivered by e-government
 l Status of e-government in Ethiopia.

1.3 Basics of E-Banking

In this sub-unit, we will learn about basics of 
e-banking.

1.4 Basics of E-Libraries

In this sub-unit, we will learn about basics of 
e-libraries.

1.5 Basics of E-Commerce

In this sub-unit, we will learn about basics of 
e-commerce.

1.6 System Analysis

In this sub-unit, we will learn about system analysis. 
The topics to be learnt are:
 l Overview
 l System problems

Review of the unit

 l E-learning is a flexible term used to describe a 
means of learning through technology such as a 
network, browser, CD-ROM or DVD multimedia 
platforms.
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	 l	The main advantages of e-learning are:
		 First-in market, Learner control, Enhanced 

retention, Timely and Easy access, Interactive 
Mode, Assessment and Feedback, Up-to-date 
content, State-of-the-art Environment.

	 l	Technology is the most variable element in 
e-learning.

	 l	Technology necessary for e-learning are:
		  Information Technology, Telecommunication 

Technology and Internet connection. 
	 l	E-government is also known as electronic 

government.
	 l	The main advantage of e-government is to 

improve the efficiency of the current government 
system.

	 l	E-government applications empower citizens and 
businesses to transact government businesses 
online.

	 l	The four types of e-government services are G2C, 
G2B, G2E and G2G.

	 l	The status of e-government in Ethiopia will 
certainly improve in the coming years with 
implementation of ICT.

	 l	E-banking also known as Electronic Fund 
Transfer (EFT), uses computer and electronic 
technology as a substitute for checks and other 
paper transactions.

	 l	E-libraries are the physical sites and/or websites 
that provide 24-hours online access to digitized 
audio, video, and written material.

	 l	E-commerce is the purchasing, selling, and 
exchanging of goods and services over computer 
network through which transactions or terms of 
sale are performed electronically.

	 l	A system is defined as a collection of related 
components that interact to perform a task in 
order to accomplish a goal.

	 l	The Systems Development Life Cycle (SDLC) is a 
step-by-step process that many organizations 
follow during systems analysis and design.

	 l	The Feasibility Study should include an initial 
statement of the functional and technical (non-
functional) requirements for the system.

	 l	The objective of System Analysis is to gather data, 
analyse the data and write a report.

Role of the students

In this unit, the students are supposed to learn 
Information Systems. The activity based method 
should be followed to understand the subject matter 
which is the best way of better understanding of the 
subject matter. At present, students have better ways 
of learning ICT.

	 l	The way in which students learn has changed, 
and that sitting in a passive mode in large lecture 
halls is not the expectation.

	 l	Due to advancement in technology, today’s 
students are different than those for whom 
the educational system was initially designed 
for because students “think and process 
information fundamentally differently from 
their predecessors” having grown up around 
computers, video games, and the Internet.

	 l	They represent the generation which is 
completely surrounded by ICT where e-mail, 
instant messaging, and cell phones are integral 
parts of their lives.

Additional Class Activities for Gifted Students or slow learners

  ACTIVITY 1.1: Learning Models 

Students in their class will discuss and demonstrate the learning models.

What is e-learning?

E-learning can be thought of as the learning process created by interaction with digitally delivered content, 
services, and support. It involves intensive use of Information and Communication Technology to serve, 
facilitate, and revolutionize the learning process.
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Learning Models

Figure 1.1 shows three main learning models that we have come to recognize over the years.

Fig 1.1: Learning models

	 1.	Traditional learning. In traditional learning, students go to a school, college, or other physical space to learn. 
Information and Communication Technology can enhance the learning process, but is not necessarily 
included. For example, data show and presentations can be thought of as an implementation of e-learning 
within a traditional learning institution.

	 2.	Distance learning. In distance learning, an instructor and students are separated by time, location, or both. 
Education or training courses are delivered to remote locations via synchronous or asynchronous means of 
instruction. Distance education does not preclude the use of the traditional classroom.

	 3.	Blended learning. Blended learning combines multiple models to learning. For example, students in a 
traditional class can be assigned both print-based and online materials.

Activity 1.2:	 E-learning—a Tool to Facilitate Teachers’ Work and Enhance the Learning 
Process

The ICT teacher in the class will explain and demonstrate the concept of e-learning and discuss how it can 
be made more interesting.

E-learning

E-learning refers to formal and non-formal education that uses electronic delivery methods such as Internet-
based learning delivery packages, CD-ROM, online video conferencing, websites or e-mail to manage the 
relationship between teacher and learners.
	 Some ways to use the e-learning tool effectively are:
Create games, quizzes or crosswords

	 l	Create activities, matching games, crosswords or quizzes 

	 l	Help students revise and assimilate new material
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	 l	Conduct online exams or print randomized tests

	 l	Share and exchange activities with other teachers

Make them available to students or groups

	 l	Your activities are available online

	 l	You can limit access to your materials or make them accessible via web address

	 l	Create group/class web pages with activities, forum, important information, files

	 l	Send individual or mass e-mail messages to your students.

View and analyse results

	 l	Results are calculated automatically and stored in your database

	 l	Results can be compared and sorted by different criteria

	 l	You can export results to other programmes, and use them in the way you want

	 l	Use some website, e.g., www.kubbu.com to stimulate your students and improve their results.

  ACTIVITY 1.3: Electronic Payment Systems

Students in their class will explain and discuss about the electronic payment systems, their risks and 
security.

Electronic Payment System

An electronic payment system is needed for compensation for information, goods and services provided 
through the Internet—such as access to copyrighted materials, database searches or consumption of system 
resources—or as a convenient form of payment for external goods and services—such as merchandise and 
services provided outside the Internet. It helps to automate sales activities, extends the potential number of 
customers and may reduce the amount of paperwork.
	 Some electronic payment systems available today are given below:

	 l	Secure Socket Layer (SSL): Client submits credit card information using encryption based on public keys.
	 l	CyberCash: Customer registers credit card with CyberCash and selects a signature key. Requires special 

software on the client, but hides credit card information from merchant.
	 l	Secure Electronic Transaction (SET): The customer obtains a signature key from the card issuer. This method 

requires special software running on the client to encrypt and sign credit card information.
	 l	Open Market: It provides multi-mechanism collection services for web browsers.
	 l	Mondex: It provides smart-card based electronic currency.
	 l	Electronic Check: It provides a PC card-based credit-debit payment instrument that can be sent across the 

Internet, but clears through the existing banking network.

Risks and Security

From the customer’s perspective:
	 l	 stolen payment credentials and passwords
	 l	dishonest merchants or financial service providers
	 l	disputes over quality of services or goods
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From merchant’s perspective:
	 l	 forged or copied payment instruments
	 l	 insufficient funds in customers account, especially with off-line payment systems
	 l	dishonest or slow financial service providers

From the financial service provider’s perspective:
	 l	 stolen customer or service credentials
	 l	 forged or copied payment instruments
	 l	 customers not paying (applies only to credit models)

	 The risk may be shifted in one direction or the other by using a credit or debit model and by special 
agreements.

  ACTIVITY 1.4: E-Government Websites

The ICT teacher in the class will discuss and demonstrate about the e-government Websites

What Are Good E-government Websites?

Among the factors that make a good e-government website, the most important are perhaps:
	 l	 the quantity and quality of the information provided;
	 l	 the way in which this is presented and made available;
	 l	 the level of interactivity of the site;
	 l	 the availability of partial or full online services to the public;
	 l	 the level of accessibility to the disabled and other visitors using alternative technologies.

Examples of E-government Websites

Some examples of good e-government websites are given below:
	 l	Singapore eCitizen Portal (URL: www.ecitizen.gov.sg)
	 l	South African Government (URL: www.gov.za)

Answers to Textbook assessments

Assessment 1.1

Fill in the Blanks

	 1.	E-learning
	 2.	 IT, Telecommunication, Internet connection
	 3.	Learning Management System
	 4.	Telecommunication

State Whether True or False

	 1.	True	 2.	 False	 3.	 False
	 4.	True

Answer the Following

	 1.	E-learning is a flexible term used to describe a 
means of teaching through technology such as a 
network, browser, CD-ROM or DVD multimedia 
platforms.

	 2.	Advantages and disadvantages of e-learning are 
given below:

		 Advantages: The e-learning setup, if implemented 
in quality way, offers many benefits to the users. 
The main advantages of e-learning are:

	 (i)	 First-in Market: 	The e-learning model enables 
the placement of content on the Web as soon 
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as it is ready without having to wait for 
printing, packaging and shipping through 
distribution channels. This results in cutting 
down the lead-time between the development 
of a course and its availability to learners. The 
early availability of content gives the learner a 
headstart over others.

	 (ii)	 Learner Control: 	You can learn at any time and 
at any place. All you need for e-learning is a 
Web connection. You can limit the duration 
of an e-learning session to study only the 
volume of content that you can fully absorb. 

	 (iii)	 Enhanced Retention: 	Since you follow a learning 
style that suits you, e-learning enhances your 
retention. Also, the e-learning material is 
delivered in small logical modules known as 
skillets. This results in better retention and 
recall for a learner.

	 (iv)	 Timely and Easy Access: E-learning is available 
24 hours a day, 7 days a week. Therefore, 
e-learning enables you to learn at the time that 
is convenient to you. The timely retrieval of 
the learning material enables you to practice 
what you have learned. You can gain access 
to the e-learning material from any location 
that has a computer and an Internet access.

	 (v)	 Interactive Mode: As an e-learner, you have 
access to a web tutor at all times. Experts 
are also available for you to resolve content-
related queries.

		  E-learning also allows you to chat with co-
learners on different topics related to their 
subject and participate in discussion forums. 
Chat is the typed discussion among participants 
who are online at the same time; it is just like 
telephone conversation, except that messages are 
typed rather than spoken.

	 (vi)	 Assessment and Feedback: E-learning provides 
you with assessment exercises that test you 
on the course that you are learning. On-line 
tests are typically optional self-initiated tests. 
You get a dynamic set of questions to answer. 
Unlike tests in CBT (Computer-based Training), 
these tests give you a feedback comparing your 
performance with that of other learners who 
have attempted the test.

	 (vii)	 Up-to-date Content: The e-learning technology 
allows the dynamic updation of information 
on courses. Therefore, unlike CBT or books, 
the content in an e-learning course is updated 
regularly. This enables you to gain access to 
the latest information on the course.

	 (viii)	 State-of-the-art Environment: The future of 
all activities in educational and commercial 
spheres is on the Internet. Therefore, most 
of the new development in educational 
technologies is Web-based. Most transactions 
are changing from physical to virtual, and 
the Internet is at the core of everything. 
Therefore, with e-learning, you work in a 
state-of-the-art environment that is going to 
be the environment of the future.

		 Disadvantages: Although e-learning is very useful 
for the users, but it suffers from some limits that 
lead to its disadvantages. The disadvantages of 
e-learning are given below:

	 (i)	 Up-front Investment: 	Up-front investment 
required for an e-learning solution is larger 
due to development costs. Budgets and cash 
flows will have to be negotiated.

	 (ii)	 Technology Issues: 	Technology issues that 
play a factor include whether the existing 
technology infrastructure can accomplish 
the training goals, whether the additional 
technology expenditures can be justified, and 
whether compatibility of all software and 
hardware can be achieved.

	 (iii)	 Inappropriate Content: Inappropriate content 
for e-learning may exist according to some 
experts, though is limited in number. Even 
the acquisition of skills that involve complex 
physical/motor or emotional components 
(for example, juggling or mediation) can be 
augmented with e-learning.

	 (iv)	 Cultural Acceptance: Cultural acceptance is 
an issue in organizations where student 
demographics and psychographics may 
predispose them against using computers at 
all, let alone for e-learning, unavailability of 
required technologies.
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	 (v)	 Portability: Portability of training has become a 
strength of e-learning with the proliferation of 
network linking points, notebook computers, 
PDAs, and mobile phones, but still does not 
rival that of printed workbooks or reference 
material.

	 (vi)	 Reduced Social and Cultural Interaction: 
Reduced social and cultural interaction can be 
a drawback. The impersonality, suppression 
of communication mechanisms such as 
body language, and elimination of peer-to-
peer learning that are part of this potential 
disadvantage are lessening with advances in 
communications technologies.

	 3.	Technology is the most variable element in 
e-learning. The more advanced the technology 
becomes, the more options there are to further 
e-learning. It has increasingly limitless potential.

	 	The necessary technologies for e-learning are 
listed below:

	 •	 Information Technology
	 •	 Telecommunication Technology
	 •	 Internet Connection
	 4.	The e-learning programs feature real-world 

applications and use a multi-pronged approach 
involving interactive online Internet web casts, 
simulation software and self-study assignments 
with a mentor on call. The courses consist of a 
set number of modules delivered over a given 
time frame. Presentations and group discussions 
are conducted using a live, interactive software 
system. For each e-learning module the users 
generally have an initial reading assignment 
(which is delivered to him/her in electronic 
format in advance of the online presentations). 
Figure 1.2 shows a model of e-learning.

Fig. 1.2: Model of support for learners using e-learning in workplaces

	 There are coursework or problems to be submitted 
and in some cases there are practical exercises, using 
simulation software and remote labs that the user can 
easily do from his/her home or office. Users also have 
ongoing support from the instructors as well as course 
coordinators via phone, fax and e-mail.

Suggested Activities

Refer to sub-unit 1.1 of the Student Textbook for 
doing the activities.

Assessment 1.2

Fill in the Blanks

	 1.	e-government
	 2.	E-administration
	 3.	G2C, G2B, G2E, G2G

State Whether True or False

	 1.	True	 2.	 True	 3.	 False

	 4.	False	 5.	 True
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Answer the Following

	 1.	Some electronic systems are listed below:
	 (i)	 E-learning system
	 (ii)	 E-government system
	 (iii)	 E-banking system
	 (iv)	 E-libraries system
	 (v)	 E-commerce system
	 2.	E-government, also known as electronic 

government, refers to government’s use of 
information technology to exchange information 
and services with citizens, businesses, and other 
arms of government.

or
		  “E-government” refers to the use by government 

agencies of information technologies (such as 
Wide Area Networks, the Internet, and mobile 
computing) that have the ability to transform 
relations with citizens, businesses, and other arms 
of government.

	 3.	There is a great impact of e-government on society. 
Some advantages of implementing an electronic 
government are given below:

		 The main advantage of an electronic government 
is to improve the efficiency of the current 
government system. That would in return 
save money and time. The introduction would 
also facilitate better communications between 
governments and businesses. An example would 
be, e-procurement which facilitates Government-
to-Government (G2G) and Business-to-Business 
(B2B) communication; this will permit smaller 
business to compete for government contracts as 
well as larger business. This will have the advantage 
of creating an open market and stronger economy. 
Business and citizens can obtain information at a 
faster speed and it is possible at anytime of the 
day.

		  In addition, moving away from a heavily paper 
based system to an electronic system would reduce 
the need for man power. Thus, this would allow 
the process to be handled by lesser employees 
and therefore to reduce operations cost.

		 The ability of an e-government service to be 
accessible to citizens irrespective of location 
throughout the country brings the next and 
potentially biggest benefit of an e-government 

service. The society is moving toward the mobile 
connections.

	 4.	The different services by e-government are given 
below:

		 Analogous to e-commerce, which allows 
businesses to transact with each other more 
efficiently Business-to-Business (B2B) and 
brings customers closer to businesses i.e., 
Business-to-Consumer (B2C), e-government 
aims to make the interaction between 
government and citizens (G2C), government 
and business enterprises (G2B), and  
inter-agency relationships (G2G) more friendly, 
convenient, transparent, and inexpensive. Figure 
1.3 shows four types of e-government services.

Fig. 1.3: Four types of e-government services

		 The four types of e-government services are 
given below:

	 (i)	 Government-to-Citizen (G2C): This includes 
information dissemination to the public, basic 
citizen services such as license renewals, 
ordering of birth/death/marriage certificates 
and filing of income taxes, as well as citizen 
assistance for such basic services as education, 
healthcare, hospital information, libraries, and 
the like.

	 (ii)	 Government-to-Business (G2B): These 
transactions include various services 
exchanged between government and the 
business community, including dissemination 
of policies, memos, rules and regulations.

	 (iii)	 Government-to-Employee (G2E): These 
services encompass G2C services as well 
as specialized services that cover only 
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government employees, such as the provision 
of human resource training and development 
that improve the bureaucracy’s day-to-day 
functions and dealings with citizens.

	 (iv)	 Government-to-Government (G2G): These 
services take place at two levels—at the local 
or domestic level and at the international 
level. G2G services are transactions between 
the central/national and local governments, 
and between department-level and attached 
agencies and bureaus. At the same time, 
G2G services are transactions between 
governments, and can be used as an instrument 
of international relations and diplomacy.

Suggested Activities

Refer to sub-unit 1.2 of the Student Textbook for 
doing the activities.

Assessment 1.3

Fill in the Blanks

	 1.	E-banking	 2.	 E-libraries

	 3.	B2B, B2C, C2B, C2C
	 4.	 speed, cost saving, no boundaries, ease of 

networking

State Whether True or False

	 1.	True	 2.	 False	 3.	 False
	 4.	True	 5.	 False

Answer the Following

	 1.	The working of e-banking is given below:
		 E-banking or electronic banking involves a 

variety of transactional areas, ranging from 
direct deposit of paychecks, obtaining cash from 
an ATM, to using a debit card to purchase goods 
and services. Electronic banking and the resulting 
financial transactions involve the transmission 
of financial data and transfer of funds through 
various modes such as computers, phones, and 
other technological advanced devices. Figure 1.4 
shows the dataflow diagram for bank account 
customer.

Fig. 1.4: Dataflow diagram for bank account customer
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	 2.	The working of e-libraries is given below:
		 E-library or Digital Library or Online Library or 

Virtual Library refers to all the library resources 
that are available online through computers and 
databases. E-libraries are different from the open 
Internet, as they have restricted access.

		 The e-library allows a user to search, retrieve, save 
and reuse the library resources in real time on the 
World Wide Web. It is a ‘virtual’ library whose 
content is the aggregation of many independent 
websites, rather than a physical collection that is 
kept in a central repository. We call each website 
a ‘resource’. The architectural model of a Digital 
Library is shown in Fig. 1.5 in terms of a data-
flow diagram.

Fig. 1.5: Architectural Model for Client/Server interaction of 
a Digital Library

	 	Data Flow: The Digital Library Index provides a 
list of resource documents, from which the end-
user can make a selection; this happens in a dialog 
between end-user and Index server. When the end-
user has selected a document of his/her interest, 
the reference to this document is passed from the 

Index server to the user’s Web browser. The user’s 
browser then downloads the referred-to content 
directly from a resource server for viewing.

	 3.	The working of e-commerce is given below:
		 E-commerce or electronic commerce works like 

conventional commerce with the same process 
of selling and purchasing goods or services for 
a price. The difference is that goods and services 
in e-commerce are bought and sold over the 
Internet using a credit card. Transactions can 
be done globally 24 hours a day and 7 days a 
week, unlike conventional commerce. There 
are no weekly holidays or closing time as with 
conventional stores.

		 The Process
		 The merchant showcases the products intended 

to be sold on a website and specifies the price of 
each product. The customer logs on to the website, 
chooses products and adds them to a shopping 
cart. The customer connects to the transaction 
server and gives credit card details to purchase 
the goods. The merchant’s transaction server then 
connects to the credit card processing server to 
check if the customer has the required funds to 
pay for the goods and services purchased.

		 Once the processing server approves of the 
transaction and reports that the customer has 
funds, it authorizes the transfer of funds from 
the customer’s bank to the bank of the merchant. 
On receipt of the money, the merchant’s server 
confirms the sale to the customer and the 
products are delivered to the customer by the 
merchant. Figure 1.6 illustrates the working of 
e-commerce:

Fig. 1.6: Working of e-commerce
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Suggested Activities

Refer to sub-units 1.3 to 1.5 of the Student Textbook for doing activities 1 and 2.

ACTIVITY 3:   Choosing a Topic (say E-commerce) and Designing a Presentation Which Gives 
Full Information on the Topic

In groups, students will choose a topic (say E-commerce) and design a presentation which gives full information 
on the topic.
	 First of all design a presentation on E-commerce. To present a slide show, perform the following steps:

	 	Click Slide Show tab.
	 	Click From Beginning button (see Fig. 1.7).

Fig. 1.7: Starting slide show

	 	Run the presentation by clicking the left mouse button at each slide. At the black screen, click the left 
mouse button again (see Fig. 1.8).

	 	
	 Slide-1	 Slide-2

	 	
	 Slide-3	 Slide-4
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	 Slide-5	 Slide-6

	 	

	 Slide-7	 Slide-8

	 	
	 Slide-9 	 Slide-10

	 	

	 Slide-11	 Slide-12
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	 Slide-13	 Slide-14

	

Slide-15

Fig. 1.8: Slides in the presentation

	 		 Press Esc to exit the slide show.

Answers to Review Questions

Fill in the Blanks

	 1.	 system	 2.	 Modelling
	 3.	Systems analysis and design
	 4.	System Analysis

State Whether True or False

	 1.	True	 2.	 False
	 3.	False	 4.	 True

Multiple Choice Questions

	 1.	 (d)	 2.	 (d)

	 3.	 (b)	 4.	 (a)

Match the Following

	 1.	 (d)	 2.	 (a)

	 3.	 (b)	 4.	 (c)

Answer the Following

	 1.	System: It is defined as a collection of related 
components that interact to perform a task in 
order to accomplish a goal.

		  Identifying System Problems: One must know what 
the problem is before it can be solved. Systems 
are created to solve problems. We can think of 
the systems approach as an organized way of 
dealing with a problem.

		 Problems may be functional—that is, the system 
may be incomplete, not fulfilling all the program 
requirements. Problems may be technical (non-
functional)—for example, the system may be 
too slow, sized too small, or be obsolete and 
inefficient in terms of hardware and software. 
Problems may also relate to system cost or to 
access, limiting the ability of personal to use 
system information to full potential.

		 System problem identification step should also 
include a determination of the seriousness of 
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each problem and its effects on factors such as 
clients and financial considerations.

	 2.	Functional and Non-functional System Requirements: 
The Feasibility Study should include an initial 
statement of the functional and technical (non-
functional) requirements for the system. An 
overview of the system requirements should 
reflect a broad range of factors, for example: 

	 	 Functional, programmatic requirements; 
	 	 Information needs; 
	 	 System needs;
	 	 Interface and matching requirements; 
	 	 Processing and data flow needs; 
	 	 Storage and retrieval requirements; 
	 	 Inputs; 
	 	 Outputs; 
	 	 Workload, projected overtime; 
	 	 Validation and internal control needs; 
	 	 Security/Privacy requirements; 
	 	 Emergency response, back-up, and disaster 

recovery; 
	 	 Accessibility requirements for the disabled; 

and/or 
	 	 Space and Environment. 

		 The requirements should be stated briefly and 
in functional terms, to the extent possible. Their 
development during the Feasibility Study supports 
the selection of suitable alternatives. These 
functional and non-functional requirements are 
greatly expanded later in the planning phase 
through the Requirements Analysis.

Suggested Activities

Refer to sub-unit 1.6 of the Student Textbook for 
doing the activities.

alternative teaching approaches

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning about 
“Information Systems”.

Additional Questions

	 1.	Explain e-learning and e-government.
	 2.	Explain e-banking and e-libraries.
	 3.	Explain e-commerce.
	 4.	What are the six phases of the Systems 

Development Life Cycle (SDLC)?
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ENHANCING THE
USE OF SOFTWARE

(24 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l choose appropriate software tools to solve problems illustrate ideas clarify thinking in the other subjects 
chosen for study in Grade 11.

suGGested lesson plAn

Sub-unit
Number of 

Periods

2.1 Using Application Software 24

stRuCtuRe of the unit

2.1 using Application Software

In this sub-unit, we will learn about Using Application 
Software. The topics to be learnt are:
 l Word Processing Software
 l Presentation Software
 l Spreadsheets
 l Publishing Software
 l Databases

Review of the unit

 l Software required to solve some specific task 
of daily use is generally called application 
software.

 l Word processor is general purpose application 
software that facilitates creation and formatting 
of text documents.

unit 2   

 l Presentation software is general purpose 
application software that facilitates creation of 
presentations on any particular topic.

 l Spreadsheet is general purpose application 
software that facilitates creation of worksheets 
that stores text and numerical data in tabular form. 
Performing basic statistical analysis including 
graphs is the main utility of this software.

 l Publishing software is general purpose 
application software that facilitates creation of a 
wide variety of professional-looking publications 
intended for print or online presentation.

 l Database Management System (DBMS) is a 
general purpose application software that 
facilitates creation, maintenance, and the use of 
databse for an organization and its end users.

Role of the students

In this unit, the students are supposed to enhance the 
use of software. The activity based method should 
be followed to understand the subject matter which 
is the best way of better understanding of the subject 
matter.
 In today’s world, every student must be ICT literate 
regardless of the student’s background, gender, family 
income, geographic location, or disability. 
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	 Different type of technologies can be used by 
the students to enhance the use of software. Various 
technologies deliver different kinds of content and 
serve different purposes in the classroom. For example, 
word processing and e-mail promote communication 

skills, database and presentation software promote 
presentation skills of students. So, it is important for 
the students to choose appropriate software tools to 
solve problems, illustrate ideas, and clarify thinking 
in the other subjects chosen.

Additional Class Activity for Gifted Students or slow learners

  ACTIVITY 2.1:	U sing MS-Publisher 2007, Create a Flyer that Includes a Favorite Family Recipe 
and the Historical and Cultural Information About it

In small groups, the students will create a flyer that includes a favorite family recipe and the historical and 
cultural information about it.
Flyer and it’s Design
It is a one-page, one sided publication that is designed to be read at a glance. We should not underestimate 
the task of designing a good flyer; we need to distill the information down to the minimum number of words 
that will convey our message and arrange the text with graphics for maximum impact.
Materials Required
Collect the following material for creating the flyer:
	 (i)	 Handout on recipe	 (ii)	 Food timeline	 (iii)	 History of food
	 (iv)	 Sample recipe flyer 	 (v)	 Food, culture, and tradition
Creating Flyer 
To create a flyer, perform the following steps:
	 (i)		 Choose your favorite family recipe and research it.
	 (ii)	 Open Office Publisher 2007.
	 (iii)	 Using the sample recipe flyer, create a recipe flyer about your dish (see Fig. 2.1).

Fig 2.1: A flyer created on Ethiopian recipe

	 (iv)		 Proofread your flyer and correct any spelling or grammatical errors.
	 (v)	 Do a design check on your flyer. 
	 (vi)	 Save the publication.

Conclusion

Students can be assessed on their recipe flyer content, writing conventions, and design.
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Answers to review questions

much improved way of dealing with documents 
than the typewriter.

		 Usage areas: Word processors are commonly used 
by students, writers, authors, desktop publishing 
professionals and layout artists. These are used to 
create documents such as letters, memos, reports, 
research papers, brochures, announcements, 
newsletters, envelops, labels, and much more.

	 3.	Presentation Software: It is the application software 
which uses graphics, animation, sound and data 
or information to make presentations. It is general 
purpose application software that facilitates the 
creation of presentations on any particular topic. 
Microsoft PowerPoint is a well known presentation 
software.

		 Usage areas: Presentation software is mainly used 
in business and classrooms. It is an effective tool 
when used for training purposes and provides a 
useful environment for teachers and students.

	 4.	Spreadsheet Software: Spreadsheet software is 
general purpose software application which 
allows users to create tables and financial 
schedules by entering data and formulas into 
rows and columns in a document called a 
worksheet. Microsoft Excel is a popular example 
of spreadsheet software.

		 Usage areas: Spreadsheet software is mainly used 
for business and personal purposes. It is useful in 
many areas like accounting, budgeting, charting/
graphing, financial analysis, and scientific 
applications. For example, a teacher who uses a 
spreadsheet to record student marks is able to 
determine student averages and class means very 
quickly—that means the minute one number in 
the spreadsheet is changed, the calculations are 
up-to-date everywhere within the spreadsheet.

	 5.	Publishing Software: Publishing software is general 
purpose software which allows users to create 
and edit pages for print and online publications. 
It can be used to create flyers, posters,  
books, magazines, and brochures. 

Fill in the Blanks

	 1.	Application	 2.	 Word processor
	 3.	Spreadsheets	 4.	 database

State Whether True or False

	 1.	False	 2.	 True
	 3.	False	 4.	 True

Multiple Choice Questions

	 1.	 (b)	 2.	 (d)
	 3.	 (a)	 4.	 (c)

Match the Following

	 1.	 (c)	 2.	 (d)
	 3.	 (b)	 4.	 (a)

Answer the Following

	 1.	Application Software: Software required to solve 
some specific task of daily use is generally called 
application software. Some general purpose 
application software and their uses are given 
below: 

	 (i)	 Word Processing Software—Used for 
document creation.

	 (ii)	 Presentation Software—Used for presenting 
information.

	 (iii)	 Spreadsheet Software—Used for financial 
calculation.

	 (iv)	 Desktop Publishing Software—Used for 
desktop publishing.

	 (v)	 Database Management Software—Used for 
database management.

	 2.	Word Processing Software: It is the application 
software which processes the textual information 
including typing, editing, formatting and 
printing. 

		 Word processor is the most common software 
application. The best-known word processing 
software is probably Microsoft Word. It offers a 
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		 Desktop Publishing (DTP) involves mixing text 
and graphics to produce high-quality output 
for commercial printing, using a PC and mouse, 
scanner, laser or ink-jet printer, and DTP software. 
Microsoft Office Publisher 2007 is a well known 
DTP program with which you can create a wide 
variety of professional-looking publications 
intended for print or online presentation. 

		 Usage areas: Publishing software is mainly used 
in education, graphic design, career assistance, 
business, and crafts and personal projects etc.

	 6.	Database Software: A database is a collection of 
interrelated files in a computer system. Database 
Management System (DBMS) is general purpose 
application software that sets up and controls the 
structure of a database and access to the data. The 
most widely used form of database, especially 
on PCs, is the relational database, in which data 
is organized into related tables. Microsoft Access 
is one of the principal PC database programs.

		 Uses areas: Databases are mainly used in tourism, 
banking, airlines, schools, colleges, universities, 
credit card transactions, telecommunication, 
finance, sales, manufacturing, and human 
resources etc.

Suggested Activities

Refer to sub-unit 2.1 of the Student Textbook for 
doing the activities.

Alternative teaching approaches, 
enrichment material

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning about 
“Enhancing the Use of Software”.

Additional Questions

	 1. 	What are the following types of application 
software used for?

	 (i) 	Word processing software
	 (ii) 	Presentation software
	 (iii) 	Spreadsheet software
	 (iv)	 Publishing software

	 (v)	 Database software.
	 2.	Describe some popular features of spreadsheet 

and publishing software.
	 3. 	Describe the basic features of a relational 

database.
	 4. 	Design a database structure having two tables to 

store information about an actor/actress. The first 
table should contain personal information about 
the actor/ actress and the second table should 
contain information about his/her movies.

	 5. 	Discuss querying database and testing the 
hypotheses.
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EXPLOITING THE 
INTERNET

(21 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l understand the concept of webpage design

 l	 understand and diff erenti ate between the diff erent kinds of websites
 l	 recognize the steps required for website design
 l	 design a simple and att racti ve website.

suGGested lesson plAn

Sub-units Number of 
Periods

3.1 General Concept of Website 
Design

2

3.2 Planning a Website 3

3.3 Website Design Considerations 4

3.4 Website Development 12

stRuCtuRe of the unit

3.1 General Concept of Website Design

In this sub-unit, we will learn general concept of 
website design. The topics to be learnt are:
	 l	Definition of website
	 l	Definition of webpage
	 l	Definition of Home page
	 l	Types of website
  Static and Dynamic
	 l	Application of website

3.2 Planning a Website

In this sub-unit, we will learn about planning a website. 
The topics to be learnt are:
	 l	Determining the purpose of the website

unit 3   

	 l	Content Identification
	 l	Knowing the Audience

3.3 Website Design Considerations

In this sub-unit, we will learn about website design 
considerations. The topics to be learnt are:
	 l	Page layout of the website
	 l	Create content
  Use of images
  Page size (Creating & formatt ing tables)
	 l	Fonts (Adding design Elements)

3.4 Website Development

In this sub-unit, we will learn about website 
development. The topics to be learnt are:
 l Adding Text
 l Adding Image
 l Creating hyperlinks
 l Inserting Table
 l Inserting Frames
	 	 Adding Web eff ects 
	 	 Inserting animations
	 	 Using scripts
	 	 Using Java applets
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Review of the unit

	 l	A computer with a domain name is called a 
website (site). There are basically two main types 
of websites—Static and dynamic.

	 l	 In designing a website you should take into 
account the website’s purpose and audience.

	 l	While designing a website, you must consider 
that a successful website should have clearly 
identified goals and provide useful and attractive 
content that draws your audience to your site 
again and again.

	 l	For developing a website, you require web design 
software. For example, Web Page Maker.

	 l	A hyperlink connects the webpage with other 
pages of webpage or to pages on other websites. 

ROLE OF THE STUDENTS

In this unit, the students are supposed to exploit the 
Internet. The activity based method should be followed 
to understand the subject matter which is the best way 
of better understanding of the subject matter.
	 Today the students rely on the computer for both 
educational and entertainment purposes. You already 
know that the Internet is an extremely useful resource 
for every computer user.   Students can conduct 
research for school projects, chat with friends, surf the 
Web and share music and photographs. With the wide 
variety of websites students visit on a daily basis, it 
is important to have a behind-the-scenes look at how 
the websites  are created. An ideal way to do this is by 
creating Web design projects that allow the students to 
explore design tools and techniques.

Fig. 3.1: Online friendship

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

  ACTIVITY 3.1: The Risks of Online Intimacy

The teacher will explain the risks of online intimacy to students.

Online Intimacy

Online intimacy means a successful friendship relation using the Internet. 

How To Make Online Friends?
It is not very easy to take care of a friendship with someone you cannot 
see or feel. This is the main issue that online friendship faces. Without the 
physical presence of the person, it is very difficult to form a friendship 
that would last forever. Yet some people argue that not being able to see 
each other is an advantage. Some people are not quite confident about 
their looks and some are afraid to speak up in public or a group. Online 
friendship is very helpful for such people (see Fig. 3.1).

Relationship Websites 
The relationship websites give us the opportunity to meet a friend online. 
For example, personals.yahoo.com, www.friendsonline.ca, www.onelovenet.com, www.makefriendsonline.com, www.
newfriends4u.com, ethiopianpersonals.com. These websites may expose you to a wider variety of friends than is 
possible in more conventional way, as through school, church, or club activities.

Risks of Online Intimacy

	 l	 Online life and real life are not the same
	 l	 Online friendship can be emotionally intense
	 l	 Online text communication does not allow nonverbal communication
	 l	 People meeting online showcase their good points only
	 In summary, we can say that Internet does allow the possibility that two friends may develop real rather 
than false intimacy.
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Answers to review Questions

		 Some well-established Websites: 
		 Some well-established websites are listed below: 
	 (i)	www.yahoo.com	 (ii)	www.google.com 
	 (iii)	www.youtube.com	 (iv)	www.telecom.net.et 
	 (v)	www.hi5.com 	 (vi)	www.nazret.com
	 (vii)	www.ebay.com
	 (viii)	www.ethiopianreview.com

	 2.	The two types of websites are static and dynamic. 
These are quite different from one another when 
it comes to attributes and utilization. A website 
must attract people of all ages. 

		 You will have to identify a website type 
depending on your needs and what you would 
like to get out of your website.  Both static and 
dynamic websites are appropriate alternatives. 
If you want to develop a professional site with 
lots of capabilities then a dynamic is an excellent 
choice. Alternatively, if you are a newbie in this 
field and want to build any sort of website, then 
you can think about developing a static website. 

		 Remember to consider just how much time you 
want to put into your website and what you 
would like to offer to the website visitors, and 
the appropriate site will be simple to choose.

	 3.	Website Planning: In designing a website you 
should take into account the website’s purpose 
and audience. A good designer knows how to 
achieve the effects called for in the most flexible, 
efficient, and elegant way. To design a website, you 
should have a thorough knowledge in hypertext, 
multimedia, Java, and other programming 
possibilities as well as knowledge about how 
particular website structures affect an audience. 

		 Determining the Purpose of the Website
		 Determining the purpose of the website is most 

important for its success. First of all you should 
develop a plan. With a good plan, you may 
know in advance what you are going to do and 
the correct order in which all things need to be 
done. 

Fill in the Blanks

	 1.	website
	 2.	 its style, the web technologies required, the 

hosting costs, the budget required for it
	 3.	web
	 4.	hyperlink

State Whether True or False

	 1.	True	 2.	 False
	 3.	True	 4.	 True

Multiple Choice Questions

	 1.	 (b)	 2.	 (c)
	 3.	 (d)	 4.	 (d)

Match the Following

	 1.	 (c)	 2.	 (d)
	 3.	 (b)	 4.	 (a)

Answer the Following

	 1.	Website: A computer with a domain name is 
called a website (site)

		 Types of Websites: There are basically two main 
types of websites—static and dynamic. 

	 (i)	Static website: It is a site like a printed paper 
as it is unchangeable once it is printed. It 
is usually built using several tools such as 
Kompozer or Dreamweaver. People are not 
able to change your webpage if you have a 
static website other than if you use WYSIWYG 
(What You See Is What You Get), text editors 
and template based editors. Only you may edit 
or transform your static website. For example, 
someone’s web portfolio is an example of a 
static site. It is only one page and is updated 
on average once a month. 

	 (ii)	Dynamic website: It is a site which allows 
the user to share data with the website. It is 
usually built with a programming language 
such as ASP, PHP or JAVA. Now-a-days most 
business websites are dynamic. One may 
enter his/her info when registering on the 
site as well as being able to buy products and 
services. For example, www.paypal.com. 
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		 The important questions to be considered are:
	 (i)	 Why you want to create a site? 
	 (ii)	 What do you want or expect your site to 

accomplish? 
	 (iii)	 Are you planning on using your site to 

generate a passive income by sell products 
or information or it is just for friends and 
family? 

	 (iv)	 Is it because others are doing it?
	 Some common purposes for Websites are:
	 (i)	 Online Store: It is the most important reason for 

building a website. If your primary purpose 
is selling physical goods, focus on creating 
an online store that gives visitors simple and 
easy shopping.

	 (ii)	 Brand Awareness: If your primary focus is on 
delivering an offline service, you may want 
an online brochure. This sort of website can 
deliver useful, practical information about 
your service and help you to develop your 
image and build trust and customer loyalty.

	 (iii)	 Online Services: For delivering an online 
service, you will have to build an infrastructure 
for the delivery of your service. This type of 
website is more complex and you will need 
to anticipate what you will feature in your 
product catalogue, and how you will handle 
online payments and process online orders.

	 (iv)	 Affiliate Commissions and Advertising: Another 
reason for building a website may be to make 
money through promoting affiliate programs, 
which offer you a commission on sales. You 
may want to earn money by putting up the 
banners of other business on your website. To 
earn a sufficient amount of money, you would 
require hard work and planning.

		  Clearly defining the purpose of your website, 
before you start building it, would ensure 
that your website is optimized to achieve 
the required purpose. After all, you can only 
meet your goals when you know what they 
are. You will have to balance your business 
goals, the needs of your audience, and your 
resources to create an effective website.

		 No matter what the purpose of your website may 
be, make sure that you keep track of the visitors 
of your website. A traffic tracking system would 
give you valuable information about the persons 
that are visiting your website. It would also enable 
you to make important decisions related to the 
optimization of your website.

Content Identification
	 	Planning is the first step in building a good 

website. After determining the purpose of the 
website, the website designer must plan the 
content. The content of a website is everything 
that is in it. The contents may include one or all 
of the following:

	 (i)	 The text on web pages.
	 (ii)	 The graphics in the website.
	 (iii)	 The colors and style of the website.
		 The important points to be considered about the 

content of a website are:
	 (i)	 What content will it contain? 
	 (ii)	 What content will drive people back to it? 
	 (iii)	 What are the sources for content?
	 (iv)	 Who will write the content?
		 The content of website is to provide the users or 

customers with information. Planning the content 
of a website is a much more comprehensive 
project than it first appears. To properly plan 
content for a website it is necessary to first make 
assumptions on what will be of most value 
to visitors. There are many tools to aid in the 
planning phase of website creation. Some useful 
online tools for planning a website are:

	 (i)	 JumpChart (URL: www.jumpchart.com)
	 (ii)	 RapidRabbit (URL: rapidrabb.it)
	 (iii)	 WriteMaps (URL: www.writemaps.com)
	 (iv)	 MindMeister 
		  (URL: www.mindmeister.com)
		 A good website developer will be able to utilize 

the above mentioned online tools and other offline 
tools (for these visit websites: www.balsamiq.com, 
www.gliffy.com, www.axure.com) along with the 
information from the content manager to decide 
on which information will be most important for 
a website.
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		 The content of website is the stuff that draws 
and keeps an audience. The composition of the 
content should follow directly from the stated 
website purpose and audience.  So the website 
designer can prepare a set of content features 
that relate to the audience’s activities, interests, 
and concerns. For example, a website about a 
school ICT fair might list rules of the fair, the 
location and details about the upcoming events, 
statements by judges, and descriptions of past 
winning projects.

		 Always remember that website design process 
builds on its content. 

Truly great websites pay attention to content 
and organization. The content of a website must 
be determined by the type of website and its 
purpose.

	 	Knowing the Audience
		 A website designer should know about  

his/her website’s audience. It may be family, 
friends, and potential employers. Using age 
appropriate material helps ensure that the online 
audience will remain interested and continue 
to visit the website. The websites which want 
to attract the young viewers should follow 
current trends and incorporate music, graphics 
and special effects that hold their interest. For 
older viewers these may have 3D graphics and 
soothing music. Website designs that have too 
much information are often difficult to navigate 
and may also deter the less experienced Internet 
audience. 

	 4.	Refer to sub-units 3.3 and 3.4 of the Student 
Textbook for the answer.

	 5.	Create a list of all of the content that you 
would like to include on your website that both 
achieves your goals and would be of interest to 
your audience. At this point, just write whatever 
comes to mind; do not try to organize it.

		 Use of Images
		 An image might be the focal point of a webpage. 

Your eye is drawn to an image because it is an 
image, not because of the position it has in the 
layout. So, look at the other elements on the page 
to make small changes (e.g., position and spacing 
etc.) to the elements and margins around the 
image to create an interesting design. Also the 
captions should go with each image separately. 

		 Align your images. Balance the graphics and 
text on a page. When you are considering your 
layout, remember that images are the major part 
of the design, not just afterthoughts.

		 Page Size (Creating and Formatting Tables)
		 Designing a professional looking website involves 

much more than simply displaying text. Page 
size plays an important role while designing 
webpages. In order to organize your page, you 
can use tables. Tables will change the look of the 
webpage. Originally, tables let people present 
data (mostly numbers) in a column format. 
Designers have found the ways to improve the 
layout of their pages using tables. Although 
a bit complicated and sometimes difficult to 
understand, tables do improve your layout and 
let you present your material in a more eye-
appealing way.

Suggested Activities

Refer to sub-units 3.1 to 3.4 of the Student Textbook 
for doing activities 1, 2, 3, 4 and 6.

  ACTIVITY 5:	 Writing a Report discussing What must be Considered When Designing a 
Website. Develop your Design into a Website. The Site Should have at Least 
Three Pages Including Various Design Elements

In small groups, the students will discuss and design website having at least three pages including various 
design elements.

What Must be Considered when Designing a Website?

Consider the following points when designing a website:
	 l	 Determine the purpose of the website.
	 l	 Know your audience.
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	 l	 Select technology to use.
	 l	 Design web architecture which must be easy to navigate for the visitors.
	 l	 The content to be posted on your website must be properly organized for the visitors so that they can 

easily access the information or content on your website.
	 l	 Have a search engine friendly URL that will be easier for visitors to remember.
	 l	 Color combination or the layout of your website design has to be appropriate.
	 l	 In order to be one the safe side, you must use limited amount of pop up ads on your website.

Developing the Design into the Website

Web Page Maker is an easy-to-use web page editor that allows you to create and upload web pages in minutes 
without knowing HTML. We will use Web Page Maker to design the website.
	 To design the website, perform the following steps:
	 1.	 Click Start → All Programs → Web Page Maker → Web Page Maker
		                                                   Or

		  Double-click on the Web Page Maker icon  on the desktop of your computer.
		  The Web Page Maker window opens (see Fig. 3.2).

Fig. 3.2: Web Page Maker window

	 2.	 Click on File menu and then click on Page Setup. The Page Setup dialog box appears  
(see Fig. 3.3). 

Fig. 3.3: Page Setup dialog box
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		  Now, set the Page Size, Margins, Headers and Footers. Change font if you want. Click OK.

	 3.	 Add two more pages in addition to the Home Page by clicking Add New Page  button in Pages tab 
under Site Contents in the Site panel (see Fig. 3.4).

Fig. 3.4: Adding pages

	 4.	 For setting the background, right click on the Work window. A menu appears. Click Properties option 
(see Fig. 3.5).  

Fig. 3.5: Clicking Properties

	 5.	 The Page Properties dialog box appears. Select the background image you want (see Fig. 3.6).

Fig. 3.6: Page Properties dialog box

		  You can select different backgrounds for individual webpages of your website. 
		  Similarly, you can set other properties from Appearance, Page Transition and Header tabs.
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	 6.	 Adding Text to Web Page

		  Click on Text  button in toolbar to add text. Click on Work window and set the size of text box.
		  Double-click in the created Text Box. It will open the Text Editor (see Fig. 3.7). Type the desired text and 

click OK. 

Fig. 3.7: Typing text in the Text Editor

		  The typed text in the Text Editor will appear in your webpage. Similarly, you can add text at 
other places of the Web page by adding separate text boxes and typing text in them. Format 
the text as per your need. After adding the text the webpage looks like the page shown in  
Fig. 3.8.

Fig. 3.8: Webpage after typing the text
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	 7.	 Adding Image
		  For adding image click Insert → Image → From files… (see Fig. 3.9).

Fig. 3.9: Getting ready to add image to webpage

		  The Open dialog box appears. Select the image to be inserted and click Open button. The selected image 
will be inserted on the Webpage. Drag and resize the image as per your requirement (see Fig. 3.10).

Fig. 3.10: Webpage after adding image
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	 8.	 Adding Navigational Elements
		  To add navigational elements click Insert → Navigation Bar... (see Fig. 3.11) or click Navigation Bar 

 button from toolbar.

Fig. 3.11: Getting ready to add Navigational elements

		  The Select Navigation Bar Style box opens. Select a template of your choice from the list and then click 
the OK button (see Fig. 3.12). 

Fig. 3.12: Selecting a template from Navigational Bar Style
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		  The Navigation Bar dialog box opens. Click OK. It will insert the selected navigation bar on the webpage. 
Drag it at the desired position on webpage (see Fig. 3.13).

Fig. 3.13: Navigational element inserted on the webpage

	 9.	 Adding Links
		  A hyperlink connects the webpage with other pages of website or to pages on other websites.

		  To add links (hyperlinks), select the text box and click on the Hyperlink  button on the toolbar. It 
will open the Hyperlink dialog box (see Fig. 3.14). 

Fig. 3.14: Hyperlink dialog box
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		  Setup the Link Type and other options. Click OK (see Fig. 3.15). Similarly set the hyperlinks of the 
desired websites for the other text boxes.  

Fig. 3.15: Setting up the hyperlinks

	 10.	 Similarly, add the text, images and hyperlinks on the other pages of the website.
	 11.	 Inserting Table
		  To insert the table, click Insert → Table… It will open the New Table dialog box. Type the number of 

Rows and Columns. Click OK. It will open the Table Editor. Type the contents of table and apply the 
desired fonts (see Fig. 3.16). 

Fig. 3.16: Typing the contents in a table

		 Click OK. The table will be inserted in the selected webpage (see Fig. 3.17).
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Fig. 3.17: Webpage after inserting table in it

	 12.	 Inserting Frames
		  To inset frames click Insert → iFrame…. It opens the iFrame dialog box. Enter the Web URL of the 

website (see Fig. 3.18).

Fig. 3.18: Entering Web URL
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		  Click OK. It will insert a iFrame in the webpage (see Fig. 3.19).

Fig. 3.19: A webpage after inserting frame in it

		  By clicking on iFrame, we can see the contents of another webpage linked through the hyperlink. 
Similarly, insert the frames on other pages (if you want).

	 13.	 Insert Animations
		  To insert animation click Insert → Marquee. It will insert an animation text box on the web page. Double-

click to open the Text Editor. Enter the text and click OK. The animation effect of the text box will be 
applied on the webpage (see Fig. 3.20).

Fig. 3.20: Inserting animation on webpage

	 14.	 Inserting interactive buttons
		  Radio button are little circles located in front of various options; selecting an option with mouse places 

a dot in the corresponding circle. Radio button are used to interact with the same webpage.
		  To insert a radio button click Insert → Form → Radio Button.
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	 15.	 Using Scripts
		  We can insert various scripts in our webpage for producing special effects on webpage. 
		  To insert the script click Insert → Ready-to-use Java Scripts…. The Predefined Javascript 

dialog box opens. Select the java script you want to insert on your web page and click OK  
(see Fig. 3.21).

Fig. 3.21: Selecting Java Script

		  The selected java script will be inserted on the webpage (see Fig. 3.22).

Fig. 3.22: A webpage after inserting Java Script

		  Now, the website has been developed. 
	 16.	 Save your design.
	 17.	 Exporting design to HTML
		  To export the website to HTML, perform the following steps:
		  Click File → Export to HTML
		  Browse the Folder where you want to place your HTML file.
		  Let us place the HTML file in C:\New Folder
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	 18.	 Now go to the selected Folder, that is, C:\New Folder (see Fig. 3.23) and open the index.html file in 
your Web Browser. 

Fig. 3.23: Selecting index.html file for browsing

		  Your webpages will look as shown in the following figures:

Fig. 3.24: WebPage-1

Fig. 3.25: WebPage-2
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Fig. 3.26: WebPage-3 showing inserted Table and Java Script effect

Fig. 3.27: WebPage-3 showing iFrame and Java Script Effect

	 19.	 Finally exit the browser and close the Web Page Maker.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning about 
“Exploiting the Internet”.

Additional Questions

	 1.	List and explain the applications of websites.
	 2.	What points must be considered in planning a 

website? Explain.
	 3.	List some web page design/authoring software.
	 4.	How will you create your own simple website? 

Explain.
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IMAGE PROCESSING AND 
MULTIMEDIA SYSTEMS

(27 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l recognise components of multi media and work with these components eff ecti vely

 l	 understand the meaning and use of multi media producti on

 l	 create interacti ve applicati ons using Multi media applicati ons.

suGGested lesson plAn

Sub-units Number of 
Periods

4.1 Basics of Multimedia 3

4.2 Multimedia Authoring 2

4.3 Introduction to Multimedia 
Authoring Tools

3

4.4 Inserting and Editing Text 3

4.5 Working with Images and 
Graphics

3

4.6 Page Transitions, Positioning 
and Motion Icon

3

4.7 Libraries 3

4.8 Working with Sound and 
Digital Movies

5

4.9 Overview of Film Editing 2

stRuCtuRe of the unit

4.1 Basics of Multimedia

In this sub-unit, we will learn about Basics of 
Multimedia. The topics to be learnt are:
	 l	Definition of multimedia
	 l	 Importance of multimedia
	 l	Components of multimedia

unit 4   

	 l	Hardware and Software requirements for 
multimedia

	 l	Multimedia and hypermedia

4.2 Multimedia Authoring

In this sub-unit, we will learn about Multimedia 
Authoring.  The topics to be learnt are:
	 l	Stages of multimedia authoring
	 l	Authoring tools examples 
	 l	File formats of sound, image and video

4.3 Introduction To Multimedia Authoring 
Tools

In this sub-unit, we will learn about Introduction to 
Multimedia Authoring Tools.  The topics to be learnt 
are:
	 l	Screen elements of multimedia application
	 l	Creating a new project
	 l	Building a basic piece
	 l	Editing an icon

4.4 Inserting and Editing Text

In this sub-unit, we will learn about Inserting and 
Editing Text.  The topics to be learnt are:
	 l	 Inserting display icon 
	 l	 Inserting text into a text field
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	 l	 Importing and pasting text
	 l	Defining and applying text style
	 l	Editing and formatting text as required

4.5	 Working with Images and Graphics

In this sub-unit, we will learn about Working with 
Images and Graphics.  The topics to be learnt are:
	 l	 Importing an image or graphic; pasting an image 

or graphic
	 l	Modifying an image or graphic
	 l	Drawing an image
	 l	Filling colour
	 l	Wait icon
	 l	Erase icon

4.6	 Page Transitions, Positioning and Motion 
Icon

In this sub-unit, we will learn about Page Transitions, 
Positioning and Motion Icon.  The topics to be learnt 
are:
	 l	Transitions
	 l	Selecting transitions
	 l	Positioning objects
	 l	Types of positions
	 l	Types of motion
	 l	Using motion icon

4.7	  Libraries

In this sub-unit, we will learn about Libraries.  The 
topics to be learnt are:
	 l	Creating 
	 l	Saving
	 l	Closing and opening
	 l	Selecting a library
	 l	Adding icons to the library
	 l	Using an icon from a library

4.8	 Working with Sound and Digital Movies

In this sub-unit, we will learn about Working with 
Sound and Digital Movies.  The topics to be learnt 
are:

	 l	Sound icon
	 l	 Importing sound
	 l	Changing the sound’s play speed
	 l	Working with digital movies
	 l	File formats
	 l	 Importing a digital movie
	 l	Setting playback conditions
	 l	Turning the sound off

4.9	O verview of Film Editing

In this sub-unit, we will learn about Overview of Film 
Editing.  The topic to be learnt is:

	 l	Basics of Film Editing

Review of the unit

	 l	Multimedia is the combined use of several media, 
such as motion-pictures, slides, and music.

	 l	Multimedia authoring involves collating, 
structuring and presenting information in 
the form of a digital multimedia, which can 
incorporate text, audio and still and moving 
images.

	 l	Multimedia authoring tools are the tools that are 
used for creating various types of multimedia 
applications.

	 l	Display icons are the ones that display some 
image or graphic.

	 l	The wait icon provides a way to pause or 
delay any onscreen action. Delay can be a set 
time interval or may require a mouse click to 
continue.

	 l	The multimedia library contains visual and audio 
elements (icons) required for developing new 
multimedia contents.

	 l	The process of editing clips includes previewing 
and trimming them to eliminate unnecessary 
material. It also includes revising clip properties 
such as speed, direction, and duration.

ROLE OF THE STUDENTS

In this unit, the students are supposed to learn about 
image processing and multimedia systems. The activity 
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based method should be followed to understand 
the subject matter which is the best way of better 
understanding of the subject matter.
	 The students already know the basics of image 
processing and multimedia from Grade 11. They are 

Fig. 4.1: Multimedia tools

supposed to enhance their knowledge in this field. 
Since the field of multimedia is rapidly changing; 
students must read related articles and resources 
available on the Internet to keep up with the latest 
developments.

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

  ACTIVITY 4.1: Use of Multimedia in the Classroom     

In small groups, the students will explain and demonstrate the use of multimedia in the classroom.

Multimedia

Multimedia is the combination of more than one type of media. The 
media types can include text, graphic images, animation, audio and video.  
Figure 4.1 shows multimedia tools.

Software Packages for Multimedia Projects

Multimedia projects can be created using many commonly used types of software. 
Some packages are: 

	 (i)	Word processing software (MS-Word)
	 (ii)	Presentation graphics software (MS-PowerPoint)
	 (iii)	Web page authoring software (Dreamweaver and FrontPage etc.)
	 (iv)	Multimedia packages (Macromedia Authorware, Adobe Premier and Macromedia Flash etc.)
	 Figure 4.2 shows Macromedia Authorware package for working with multimedia. 

Fig. 4.2: Macromedia Authorware

Types of Projects to be Developed

Students can use multimedia to create various types of classroom projects in their computer laboratory.
	 Types of multimedia projects that can be developed by students are: 
	 (i)	Electronic Portfolios: Electronic portfolios are collections or displays of student work that are 

systematically compiled to demonstrate skill level, growth over time, or understanding of a particular 
concept or discipline. Generally, teachers provide students with directions, a list of content, and guidelines 
for building a portfolio. Web page authoring software or presentation graphics software can be used to 
create electronic portfolios. 
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	 (ii)	Multimedia Slideshows: Students can create slideshows consisting of text, graphic images, audio clips, 
and/or video clips for projects about almost any subject. Presentation graphics software can be used to 
create multimedia slideshows. 

	 (iii)	Slideshow Reviews and Drills: Slideshow reviews and drills can be created by students to help 
them practice and study many types of learning content such as spelling words, vocabulary words, 
mathematical facts, and possible test questions. These slideshows can be created using presentation 
graphics software.

	 (iv)	Tutorials: Students can create multimedia tutorials that provide step-by-step directions to guide users 
through the components of a subject. Topics for tutorials can be just about anything with an instructional 
sequence. Tutorials can be created using word processing, presentation graphics, or web page authoring 
software.

	 (v)	Research Presentations: Multimedia research presentations can be created by students to present findings 
for research projects. These presentations can be developed using presentation graphics software. 

	 (vi)	Virtual Tours: Students can create virtual tours of local places of interest and field trips locations using 
presentation graphics or web page authoring software. These tours can include text descriptions of the 
places with photographs, audio clips, or video. 

	(vii)	 Interactive Storybooks: Students can write their own stories, format them, and add illustrations using 
word processing, presentation graphics or web page authoring. 

	(viii)	Class Yearbooks: Students can compile class yearbooks containing information about class activities, 
photographics, audio clips, music clips, and video clips from throughout the year. Class yearbooks can 
be compiled using web page authoring or presentation graphics software. 

Figure 4.3 shows students creating their projects in a computer lab.

Fig. 4.3: Students creating their projects in Computer Lab (Courtesy: www.flickr.com)

		 So, we see that the multimedia plays a vital role in the classroom.

Answers to review questions

Fill in the Blanks

	 1.	Multimedia
	 2.	 text, graphics, animation, sound, video
	 3.	Transitions
	 4.	 sound, images, video

State Whether True or False

	 1.	False
	 2.	True
	 3.	False
	 4.	True
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Multiple Choice Questions

	 1.	 (d)	 2.	 (a)
	 3.	 (c)	 4.	 (b)
	 5.	 (d)

Match the Following

	 1.	 (b)	 2.	 (d)
	 3.	 (a)	 4.	 (c)

Answer the Following

	 1.	Multimedia is the combined use of several media, 
such as motion-pictures, slides and music. Or in 
other words, it refers to technology that presents 
information in more than one medium—such as 
text, pictures, video, sound, and animation—in a 
single integrated communication. 

		 Components of multimedia: The multimedia 
components are:

	 (i)	 Text: In the past, content was produced 
primarily via text. Though additional elements 
have been added, text remains vital to 
multimedia applications. This is because text 
is still an effective way to communicate. In 
multimedia, text is used as headlines, subtitles, 
and captions. In addition to supplying 
content, text is used to give directions and 
communicate information, text-based menus 
and buttons help guide users through the 
multimedia applications, and electronic books, 
magazines, and reference materials still rely 
on text to inform and educate.

	 (ii)	 Graphics: Because most people like illustrations, 
visuals, graphics, 2D and 3D images are 
crucial to multimedia development. In fact, 
multimedia applications are predominately 
graphic. Because they play such a critical 
role, balancing graphics is essential. When 
designing a multimedia application, it is 
important not to get carried away with 
graphics. Adding just the right graphic and 
just the right number of graphics may help 
the user learn and retain more information in 
less time and with less effort.

		  Graphics that fit most needs are quite easy to 
find. Commercially prepared drawings called 
clipart come packaged with many application 
programs. Charts, another type of graphics, 
can convey a great deal of information in a 
very limited space. Photographs can also be 
used to enhance multimedia applications.

		  When a graphic or other multimedia object 
serves as a link to additional information 
about a topic, the link is called hypermedia.

	 (iii)	 Animation: Animation refers to graphic images 
that change or move. Animation can convey 
information, add visual interest, or draw 
attention to important information or links 
in a multimedia application. Animation is 
commonly used in advertising and marketing 
on the Web because the movement does grab 
the visitor’s attention. By illustrating proper 
techniques or explaining complex procedures, 
animation can also serve as an excellent 
learning aid in computer-based training 
programs.

		  Like clipart and stock photography, animated 
graphics are available for purchase on  
	CD-ROM or they can be downloaded 
from the Internet. In addition, commercial 
software and shareware can be purchased 
or downloaded and used to create simple or 
complex animations.

	 (iv)	 Sound: By incorporating sound into a 
multimedia application, you require the user to 
make use of yet another sense. This enhances 
the experience and increases the likelihood of 
user understanding and enjoyment.

		  In multimedia applications, sound that has 
been digitized is called audio. Audio can be 
obtained by capturing sound into a personal 
computer using a microphone, CD-ROM, or 
other input device. It can also be played from 
a synthesizer, keyboard, or other musical 
instrument that is connected to the computer 
using MIDI (musical instrument digital 
interface) port.
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	 (v)	 Video: Video can do a great deal to enhance 
a presentation, illustrate a proper technique, 
or advertise a new product. Video files are 
photographic images played at speeds that 
make it appear as if the images are in full 
motion. Video files are incredibly large because 
a huge number of images are required to give 
the appearance of motion. Delivering video 
over the Internet is particularly challenging.

		  Interactive multimedia allows users to respond 
directly to and control media elements. Users 
of interactive multimedia become active 
participants in an application instead of 
passive recipients of information.

	 2.	Stages of multimedia authoring: The five stages 
of multimedia authoring are:

	 (i)	 Analysis: What do you need to do and what 
do you use to do it.

	 (ii)	 Design: Create storyboards to tell the story of 
the project.

	 (iii)	 Development: Incorporate data and set it up as 
a prototype or model.

	 (iv)	 Evaluation: When the prototype application 
works the way you want it to, test it again, 
fine-tune it, make it attractive, and then review 
your work.

	 (v)	 Distribution: When it is ready to go (after the 
evaluation phase), make it real. Package and 
distribute it.

	 3.	The screen elements of Multimedia application Macromedia Flash shown below:

	 4.	Importing sound files: You can import various 
sound in a multimedia project. 

		 To import a sound file in Adobe Premier  
Elements 9, perform the following steps:

	 (i)	 Click Organize → Get Media → Files and 
Folders.

	 (ii)	 The Add Media dialog box opens. 
	 (iii)	  Browse the audio file you want to import and 

click Open.

	 (iv)	 The selected audio file will be imported in the 
project.

	 5.	Basics of Film Editing: The process of editing 
clips includes previewing and trimming 
them to eliminate unnecessary material. It 
also includes revising clip properties such as 
speed, direction, and duration. You can also 
edit media clips generated by other programs 
in their original applications, from within 
Adobe Premiere Elements.
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		 Trimming video clips 
		 You can create a refined good-quality video 

file by removing unwanted sections and low-
quality sections. Adobe  Premiere  Elements  9 
enables you to efficiently handle blurred, shaky, 
and unwanted low-quality and low-interest 
sections of your video file. You can easily and 
quickly edit and fine-tune the video files. Smart 
trimming enables you to trim the low-quality 
sections of a video file. Smart trim can be done 
manually and automatically. You can trim clips 
from Timeline view or Sceneline view. However, 
you can trim only one clip at a time from 
the Sceneline view. Smart trimming is of two 
types, manual and automatic. Manual Smart 
trimming is the default mode. In this mode, 
you can specify the options that determine the 
trimmable sections. In the automatic Smart trim 
mode, Adobe  Premiere  Elements automatically 
determines the trimmable sections and you can 
choose to delete them or retain them.

		 Changing clip speed and duration
		 Changing clip speed
		 To create a fast- or slow-motion effect, we can 

change clip speed. Changing clip speed changes 
the clip’s duration. Speeding up a clip removes 
frames, thus shortening the clip duration. In the 
same way, slowing down a clip repeats frames 
and thus adds to the length of a clip. For audio 
clips, a change in speed also changes pitch. The 
Time Stretch command includes an option to 
maintain the original pitch of an audio clip at 
any speed.

		 You can change a clip’s speed using the Timeline 
only—not the Sceneline.

		 Set the duration of a clip

		 The duration of a video or audio clip is the length 
of time it plays from its first frame (In point) to 
its last frame (Out point). The initial duration of 
a clip is the same as it was when the clip was 
imported or captured. Most often, you change a 
clip’s duration by trimming frames from either 

end. But you can also trim the end of a clip by 
designating a specific duration. 

		 Unlike video, still images are not limited to the 
length of the original clip. You can set their 
duration to any length.

		 Freezing and holding frames
		 Export a video frame
		 You can grab a single frame from a video clip 

to use as a still image in your current movie 
or to save as a still on your hard drive for use 
elsewhere. For example, you can use a still in 
your movie to show a character start an action, 
but then stop mid-action, frozen on the screen.

		 Play and hold a frame 
		 To make the video start out as a still image and 

then begin to play, click the Freeze Frame button  
in the Monitor panel to create a still image from 
a frame, and then insert that still image at the 
location of the original frame.

Suggested Activities

Refer to sub-units 4.2 to 4.9 of the Student Textbook 
for doing the activities.

Alternative teaching approaches, 
enrichment material

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject experts 
can be called for seminars to enrich the teaching level 
and in turn help the students in learning about “Image 
Processing and Multimedia Systems”.

Additional Questions

	 1.	Describe several multimedia environments in 
which multimedia might be used.

	 2.	Give examples of multimedia authoring tools.

	 3.	List the sound, image and video file formats.

	 4.	How will you import and paste images and 
graphics from other applications?
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Grade 12 
Minimum Learning Competencies (MLCs)

S.No. Units Minimum Learning Competencies (MLCs)

1. Information Systems Describe the advantages and disadvantages of E-learning•	
List the necessary technologies for E-learning•	
Explain how E-learning works•	
Listed some  of the electronic systems•	
Explain the advantage of E-government •	
Explain the different services by E-government•	
Explain how E-banking works•	
Explain how E-libraries works•	
Explain how E-commerce works•	
Identify system problem•	
Recognize  functional and non-functional system requirements•	

2. Enhancing the Use of 
Software

Solve problem specific software•	
Illustrating their ideas•	
Organising their contents•	
Querying their database•	
Testing hypotheses•	

3. Exploiting the Internet Define website•	
Explain the different types of websites•	
List some well•	 —established websites
Identify the type of website to be developed•	
Describe website planning•	
Explain  how to design a webpage•	
Explain how to hyperlinks in a website•	
Insert images, buttons and animations into a webpage•	
Develop content for a website with uniform formatting •	
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S.No. Units Minimum Learning Competencies (MLCs)

4. Image Processing and 
Multimedia Systems

Define multimedia•	
Explain importance of multimedia•	
List components of multimedia•	
Identify hardware and software necessary to run a multimedia •	
package
Explain each stage of multimedia authoring•	
Give examples of authoring multimedia tools•	
Identify sound, image and video file formats•	
Identify screen elements of Multimedia application•	
Identify icons and their properties•	
Enter text in the presentation window•	
Import or paste text from another application to Multimedia •	
application
Edit and format text as required•	
Import and paste images and graphics from other applications•	
Draw different shapes•	
Set the duration before a content on the presentation window is •	
erased
Erase the contents of a presentation window•	
Position objects on the presentation window•	
Set different types of motions using the motion icon•	
Use pre-stored libraries•	
Create custom libraries•	
Add and use icons to a library as required•	
Insert sound icons•	
Import sound files•	
Set the property of sound files•	
Set the property of digital movie icons•	
Import movie files•	
Identify basics of film editing•	

	Minimum Learning Competencies (MLCs)
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Grade 12 SYLLABUS

INTRODUCTION

In the preparatory schools students follow either the Social Science stream or the Natural Science stream; all 
students will continue to study IT.  
	 In the long term, students will follow a common course of IT, irrespective of which stream they are in. This 
course will cover Information Systems, Basic troubleshooting, Image processing and Multimedia Systems in some 
depth. There will also be many opportunities to use software applications and tools that they have encountered 
during studies in earlier grades.
	 In future years, students may elect to follow a more-specialist course in Computer Science covering such 
areas as Computer Architecture, Systems Analysis and Design, Data Communications and Fundamentals of 
Programming.
	 In the short term, Grade 12 students will continue to follow the old Information Technology course until it 
is appropriate to introduce the new curriculum as described above.
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GLOSSARY

A

 Absolute Reference: Commonly used in 
spreadsheet applications, it is a formulated cell 
reference that will not adjust when used to calculate 
the sum of specific cells.
 Access: A database program which is a part of the 
Microsoft Office suite of programs.
 Address Book: In e-mail, list of regular contacts’ 
addresses held in the e-mail software.
 AI (Artificial Intelligence): It is the branch of 
computer science concerned with making computers 
behave like humans.
 Alignment: Positioning of text according to the 
margins and baseline.
 Analog: It is any fluctuating, evolving, or 
continually changing process that represents data by 
measurement of a continuous physical variable. 
 Animation: The display of a sequence of images 
in a computer program or on a Webpage to give the 
impression of movement.
 Application Software: A program that is designed 
to perform specific tasks.
 ASCII:  American Standard Code for Information 
Interchange. It is pronounced (as-kee).
 Attachment:  An attachment can be a file of almost 
any kind—a document file, an image file, a sound file or 
a video clip—that we can add, i.e., attach, to an email.

b

 B2B (Business-to-Business): Companies doing 
business with each other such as manufacturers selling 
to distributors and wholesalers selling to retailers 
constitute B2B type of e-commerce.
 B2C (Business-to-Consumer): It comprises of 
businesses selling to the general public typically 
through catalogues utilizing shopping cart software.

 Backup: To copy files or data to a second source or 
media so as to safeguard it. 
 Bandwidth: A measurement of how much data 
(bits per second) can be sent through a connection.
 BCD: Binary Coded Decimal.
 Binary: A basic numbering system consisting of 1s 
and 0s. 
 BIT (Binary DigIT): It is the smallest unit of 
processing of computerized data in terms of 1s or 0s.
 Blog: (Slang term for a Weblog) A blog is a personal 
journal that can be accessed publicly and allow people 
to comment on the previously posted comments.
 Bluetooth: A wireless networking technology using 
radio waves that enables user to send data and voice 
signals between devices over short distances.
 BMP (Bitmap): It is a standard uncompressed 
format for Microsoft Windows and IBM OS/2.
 Boolean Searching: Boolean searching is built on 
a method of symbolic logic developed by George Boole, 
a 19th century English mathematician. Most search 
engines support Boolean searches.
 Booting: Starting a computer by loading the 
operating system into memory.
 Broadband: A general term used to describe a 
high-speed connection to the Internet.
 Browser: Software program that allows the user to 
find and read encoded information in a form suitable 
for display especially on World Wide Web.
 Byte: A combination of 8 bits to represent computer 
data transfer or data storage measurement. 

C

 Cell: Intersection of a row and column in a 
worksheet.
 CD-ROM (Compact Disc Read-Only Memory): A 
durable and low cost circular optical storage device 
widely used to store large amounts of information.
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	 Chat: The typed discussion among participants 
who are online at the same time; it is just like telephone 
conversation, except that messages are typed rather 
than spoken.
	 Clipart or Clip Art: A collection of image files that 
can be embedded or inserted into Web pages, word-
processed documents, PowerPoint presentations, etc.
	 Compiler: A type of system software that translates 
a source program usually written in a high level 
language into a machine language.
	 Computer: An electronic device that accepts, 
processes, stores and outputs data under the control 
of a set of instructions.
	 Computer Laboratory: A special place where 
computers are kept to operate.
	 Computer Program: A set of instructions that the 
computer carries out to perform a given task.
	 Copy, Cut and Paste: Techniques of duplicating 
or removing data from one place and inserting it 
elsewhere.
	 Copyright: New technologies have raised all kinds 
of new issues relating to copyright—mainly because it 
has become so easy to copy materials from a variety of 
digital sources.
	 Cropping: The process of removing portions of an 
image to create focus or strengthen the composition.
	 CPU (Central Processing Unit): A processor on 
an IC chip (called a microprocessor) that serves as the 
‘brain’ of the computer. 
	 Cursor: A movable, blinking symbol that indicates 
the position on a computer screen where user action 
is needed.

D

	 Data: A collection of raw facts and figures or a 
raw input which when processed or arranged makes 
meaningful output.
	 Database: A structured collection of data that can 
be used for a variety of purposes.
	 Data Communications: The moving or sharing 
of encoded information between two or more data 
sources using an electronic medium.
	 DBMS (Database Management System): 
Application software which enables the storage, 
modification, retrieval, and querying of data in a 
database.
		 Debug: To test a program and remove all the bugs 
(errors).

	 Defragmenter Utility Program: It finds all the 
scattered files on the hard disk and reorganizes them 
as contiguous files.
	 Desktop: The primary display screen of a graphical 
user interface, on which various icons represent files, 
groups of files, programs, which can be moved, 
accessed, added to, deleted, etc. on a real desk
	 Desktop Publishing (DTP): Application software 
for laying out text, graphics and pictures in order to 
produce a professional-looking publication.
	 Digital: A system that defines data in a discrete, 
non-fluctuating (i.e., non-analogue), numerical digits, 
specially 1s or 0s.
	 Digital Device: A device that works with discrete 
numbers or digits.
	 Directory:  An organizing unit in a computer’s file 
system for storing and locating files. In a hierarchical 
file system, directories can contain subdirectories as 
well as files.
	 Disk Fragmentation: The scattering of portions of 
files about the disk in nonadjacent areas, thus greatly 
slowing access to the files.
	 Disk Cleanup Utility: It can search for and remove 
unnecessary files such as temporary files, or “temp 
files”.
	 Display Icons: The icons that display some image 
or graphic.
	 Distribution List: Also called a mailing list, is a 
collection of e-mail addresses that allows you to e-mail 
multiple people at one time.
	 Domain Name System: An addressing system 
in which abbreviations are used to indicate the type 
of organization or entity instead of whole name, for 
example, .edu for educational institution.
	 DSS (Decision Support System): A computer-
based information system that provides a flexible tool 
for analysis and helps managers focus on the future.
	 Downloading: It means transmitting data from a 
remote computer to a local computer, as from a website 
to your own PC.
	 DVD: Digital Versatile Disc or Digital Video Disc.
	 Dynaset: Set of records returned by a query.

E

	 E-Banking: Use of computer and e-technology as 
a substitute for checks and other paper transactions.
	 E-Business: Business involving transactions using 
electronic media and technology.
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	 E-Commerce: Buying and selling or business 
transaction conducted on the Internet.
	 E-Governance: Application of electronic means in 
governance.
	 E-Government: Government’s use of information 
technology to exchange information and services with 
citizens, businesses, and other arms of government.
	 Electro Static Discharge (ESD): The release of 
static electricity when two objects come into contact.
	 E-Learning: Means of teaching through 
e-technology.
	 E-Libraries: The physical sites and/or websites 
that provide 24-hours online access to digitized audio, 
video, and written material.
	 E-Mail: Stands for Electronic Mail. This is a system 
of relaying messages across the Internet, from one 
Internet user to another.
	 Encryption: A system of coding that helps prevent 
access to private information on computer networks or 
on the Web.
	 EPROM: Erasable Programmable Read-Only 
Memory (“ee-prom”). It is a memory chip whose 
contents can be erased by a mechanism using ultraviolet 
light and reprogrammed for other purposes.
	 Ergonomics: The study of the interaction between 
people and machines.
	 ESS (Executive Support System): An easy-to-use 
Decision Support System made especially for top 
managers; it specifically supports strategic decision 
making.

F

	 Flash Player and Flash Professional: Software 
produced by Adobe for the development and viewing 
of animated and interactive sequences on the Web.
	 Firmware: A microprogram stored in read-only 
memory (ROM), designed to implement a function 
that had previously been provided in software.
	 Folder: An alternative word for a directory and 
which has become more common since the introduction 
of Windows.
	 Forms: Used to provide an easy to use interface for 
user to enter, view and modify data in a table.
	 Format: The arrangement of data for computer 
input or output, such as the number and size of 
fields in a record or the spacing and punctuation of 
information in a report. It is also to prepare a disk for 
reading and writing.

	 Format Painter: Helps to copy the format that has 
been applied to text and apply it to another.
	 Freeware: This is a shortened version of Free 
Software. Programmers offer their work without 
wanting pay in return.
	 FTP (File Transfer Protocol): A software protocol 
for exchanging information between computers over a 
network.

G

	 GIF (Graphics Interchange Format): It is 
pronounced “jif”, supports upto 256 colors  
(8 bits per pixel).
	 Gigabyte (GB): 2 to the 30th power (1,073,741,824) 
bytes. One gigabyte is equal to 1,024 megabytes. 
	 GIGO: It is an acronym that stands for Garbage In, 
Garbage Out.
	 Google: A popular search engine.
	 GUI (Graphical User Interface): A program 
interface that takes advantage of the computer’s 
graphics capabilities to make the program easier to 
use. Well-designed graphical user interfaces can free 
the user from learning complex command languages.

H

	 Hacker: A person who spends his/her time trying 
to gain access to information stored on other people’s 
computers all around the world.
	 Hardcopy or Hard Copy: Printed output from a 
computer, as opposed to output on screen.
	 Hardware: The physical equipment used in a 
computer system, such as the CPU, peripheral devices 
and memory.
	 Home Page: The initial page of a site on the World 
Wide Web.
	 HTML (Hypertext Markup Language): It is a 
collection of structuring and formatting tags used to 
create Web pages.
	 HTTP (Hyper Text Transport Protocol): The 
standard protocol for transferring hypertext documents 
on the World Wide Web. 
	 Hyperlinks: A word or graphic display on one 
web page that allows a computer to shift to another 
related web page.
	 Hypertext: A method of storing data through a 
computer program that allows a user to create and 
link fields of information at will and to retrieve the 
data non-sequentially.
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I

	 Icon: A picture or symbol to represent a command 
on a computer screen.
	 IC: Abbreviation for Integrated Circuit.
	 ICT: Information and Communication 
Technology.
	 IDE (Integrated Development Environment): 
A programming environment integrated into an 
application.
	 Image Processing: The set of computational 
techniques for analyzing, enhancing, compressing, 
and reconstructing images, generally with a digital 
computer.
	 Information: Meaningfully organized data.
	 Information System: A system that provides 
information to people in an organization.
	 Input: Anything that goes into a computer in order 
to be processed and/or stored. 
	 Input Device: A device that allow people to put 
data into the computer in a form that the computer 
can use. For example, keyboard.
	 Internet Explorer: A browser produced by the 
Microsoft Corporation and supplied together with the 
Windows operating system.
	 Integrated Circuit (IC): A circuit of transistors, 
resistors, and capacitors constructed on a single 
semiconductor wafer or chip, in which the components 
are interconnected to perform a given function.
	 Interface: This is any type of point where two 
different things come together. Most often, the term is 
used to describe the programs between you and your 
computer like Windows, UNIX and others. What you 
see on the screen is the interface between you and 
what your computer is doing.
	 Interpreter:  It translates and executes source 
program, written in high level language, statement-
by-statement.
	 Internet: The Internet is a network of networks all of 
which use the same set of communications protocols. 
	 Intranet: A private network for communications 
and sharing of information that, like the Internet, is 
based on TCP/IP but is accessible only to authorized 
users within an organization. An organization’s intranet 
is usually protected from external access by a firewall.
	 ISP (Internet Service Provider): A company that 
provides access to the Internet.
	 IT (Information Technology): The development, 
implementation, and maintenance of computer 

hardware and software systems to organize and 
communicate information electronically.

J

	 JAVA: A high-level programming language 
developed by Sun Microsystems.
	 Joystick: A device that looks a bit like a gear lever 
in a car. This is connected to a computer and is used 
mainly for controlling the cursor in fast action games.
	 JPEG (Joint Picture Experts Group): It is 
pronounced “jay peg”. It supports 16.7 million colors 
(24 bits per pixel).

K

	 Keyboard: An input device which is used to 
enter information which the computer displays or 
processes.
	 Kilobyte (KB): This is about a thousand bytes of 
space. In reality, it is two to the 10th power or 1,024 
bytes.

L

	 LAN (Local Area Network): A network that 
links together computers and peripheral equipment 
within a limited area, such as a building or a group of 
buildings.
	 Language Processor: Software that converts a 
high level language or assembly language code into 
machine understandable form.
	 Laptop Computer: A computer that is light and 
can easily be carried around.
	 Laser Printer: A type of printer that produces high-
quality output at a reasonable speed.
	 LCD (Liquid Crystal Display): A method of 
displaying readings continuously using a liquid-
crystal film, sealed between glass plates that changes 
its optical properties when a voltage is applied.
	 Learning Management System (or LMS):  A 
software package that enables the management 
and delivery of learning content and resources to 
students.
	 Linker: A program specifically designed to combine 
or link together a large number of programs forming 
a single executable instruction set for these programs 
that can be loaded into the systems memory for quick 
execution.
	 Login: To attach to a computer using the user’s ID.
	 LOGO (Logic Oriented, Graphics Oriented): A 
high level programming language specifically designed 
for its ease of use and graphics capabilities. 
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M

	 Mainframe: Second largest computer available 
after the supercomputer.
	 M-Commerce: Buying and selling of goods and 
services through wireless technology.
	 Megabyte (MB): About a million bytes of space. 
Actually it is 2 raised to the 20th power or 1,048,576 
bytes of space.
	 Memory: Internal storage areas in the computer.
	 Microcomputer: A category of computer that is 
generally used for personal computing, for small 
business computing, and as a workstation attached 
to large computers or to other small computers on a 
network.
	 Microprocessor: An integrated computer circuit 
that performs all the functions of a CPU.
	 Microsoft Office: A suite of programs produced by 
Microsoft Corporation, comprising a Word-processor 
(Word), a Spreadsheet (Excel), a Presentation Program 
(PowerPoint), an Email package (Outlook), a Database 
program (Access), and a Desktop Publishing package 
(Publisher).
	 MIS (Management Information System): A 
computer-based information system that uses data 
recorded by Transaction Processing System as input 
into programs that produce routine reports as 
output.
	 MODEM: Stands for MOdulator and DEModulator. 
It is a device that changes data from digital (computer 
language) to analog (phone line language) and then 
back again.
	 Moodle: An Open Source Course Management 
System (CMS), also known as a Learning Management 
System (LMS) or a Virtual Learning Environment 
(VLE).
	 Motherboard: The main circuit board of a 
microcomputer.
	 Monitor: The screen on which output from a 
computer is displayed.
	 Mouse: A pointing device that is used by moving it 
around on the desk and pressing (clicking) a button.
	 MPEG (Motion Picture Experts Group): A format 
to make, view, and transfer both digital audio and 
digital video files.
	 MS-Access: Database application software, 
provided by Microsoft.
	 MS-Excel: Spreadsheet application software, 
provided by Microsoft.

	 MS-PowerPoint: Presentation software, provided 
by Microsoft.
	 MS-Word: Word processing application software, 
provided by Microsoft.
	 Multimedia: The integration of two or more types 
of information (text, images, audio, video, animation, 
etc.) in a single application.
	 Multimedia Authoring: It involves collating, 
structuring and presenting information in the form of 
digital multimedia, which can incorporate text, audio, 
and still and moving images.
	 Multimedia Authoring Tools: Tools that are used 
for creating various types of multimedia applications.

N

	 Nanosecond: A billionth of a second. Many 
computer operations, such as the speed of memory 
chips, are measured in nanoseconds. Nanosecond is 
often abbreviated as ns.
	 Navigation: It is the process of finding the way, 
i.e., navigating, around a series of menus within a 
computer program or finding the way around the 
World Wide Web by means of a browser.
	 Netiquette: The rules of etiquette that apply when 
communicating over computer networks, especially 
the Internet. 
	 Network: A system containing any combination 
of computers and its peripherals, used to transmit or 
receive information.
	 Newsgroup: An online discussion community 
found on the USENET system. These groups cover 
thousands of different topics of information and are 
offered free of charge.
	 Node: In networks, a processing location. A node 
can be a computer or some other device, such as a 
printer.
	 Notebook Computer: A type of Laptop Computer, 
but lighter and thinner—and therefore easy to carry 
around.

O

	 OAS (Office Automation System): It combines 
various technologies to reduce the manual 
labour required in operating and efficient office 
environment.
	 Offline: Not connected to a computer or network 
of computers.
	 Online: Connected to a computer or network of 
computers, especially the World Wide Web.
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	 Operating System: A system software program 
that works as a bridge between computer hardware 
and the user. Operating systems perform basic tasks, 
such as recognizing input from the keyboard, sending 
output to the display screen, keeping track of files 
and directories on the disk, and controlling peripheral 
devices such as disk drives and printers. 
	 Outlook: A popular e-mail program, part of the 
Microsoft Office suite of programs.
	 Output: Anything that comes out of a computer 
after being processed.
	 Output Device: A device that translates information 
processed by the computer into a form that humans 
can understand.

P

	 PDA (Personal Digital Assistant): A handheld 
device that combines computing, telephone/fax, and 
networking features and serves as an organizer for 
personal information.
	 PDF (Portable Document Format): A technology 
developed by Adobe and was designed to capture all 
of the elements of a printed document and place it in 
a single image file.
	 Pen Drive: A secondary storage device that can be 
used to easily transfer files between USB-compatible 
systems.
	 Peripheral: Any external device attached to a 
computer.
	 Pixel: The smallest element of an image that can be 
individually processed in a video display system.
	 Plotter: A computer output device that draws 
images on paper using a pen.
	 Podcasts: Online broadcasts that can be 
downloaded to portable devices.
	 Portal: A Webpage, website or service that acts as 
link or entrance to other websites on the Internet.
	 Printout: Anything produced on a printer after 
being processed by a computer program.
	 Primary Key: A set of one or more values in a 
database that uniquely identifies a record in a table.
	 Primitives: The LOGO commands are known as 
‘Primitives’.
	 Procedure: The sequence of actions or instructions 
to be followed in solving a problem or accomplishing 
a task. It may be used at one or more points in a 
computer program.
	 Processor: A device that processes programmed 
instructions and performs tasks. The speed at which 

the CPU processes information internally is measured 
in MegaHertz (MHz) and GigaHertz (GHz). 1 GHz is 
equal to 1,000 MHz.
	 Programmable Read-Only Memory (PROM): 
A special memory chip that is blank when first 
purchased. It can be written to by the user by using a 
special hardware program. Once the data is written to 
it, it cannot be erased or changed.
	 Protocol: A set of rules governing the format of 
messages that are exchanged between computers.
	 Public Domain: Material that is copyright free, 
whose copyright has expired, or which cannot be 
copyrighted.

Q

	 Query: Used to retrieve information on a certain 
condition from a database.

R

	 RAM (Random Access Memory): A volatile 
computer memory available to the user for the 
temporary storage and manipulation of data. 
	 Relative Reference: The default reference in a 
spreadsheet package.
	 Reports: Used to present data in a printed 
format.
	 Resolution: A measure of the number of pixels or 
small dots displayed on a computer display screen, 
printer or scanner.
	 ROM (Read-Only Memory): A memory in which 
program instructions, operating procedures, or other 
data are permanently stored, generally on electronic 
chips during manufacture, and that ordinarily cannot 
be changed by the user or when power is switched 
off.
	 Router: A device in a network that handles message 
transfers between computers. 

S

	 Scroll Bar: A widget found in graphical user 
interface and used to show and control which portion 
of a document is currently visible in a window. A 
window may have a horizontal or, vertical scroll bar, 
or both.
	 Scanner: A device used to convert hard copy, e.g., 
a printed page, photograph or photographic negative, 
into a form that can be stored on a computer.
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	 Screen Saver:  A moving picture or pattern that 
appears on the screen when you have not used the 
mouse or keyboard for a specified period of time.
	 Scroll: To move up and down or from side to side 
through a document or a Window to view or access all 
of its contents.
	 Search Engines: A computer program that searches 
documents, especially on the World Wide Web, for 
a specified word or words and provides a list of 
documents in which they are found.
	 Serial Port: A port or interface that can be used for 
serial communication, in which only 1 bit is transmitted 
at a time. Most serial ports on personal computers 
conform to the RS-232C or RS-422 standards.
	 Server: This is a mainframe computer that serves 
the other computers attached to it.
	 Sheet Tab: In spreadsheet applications, this refers 
to a tab at the bottom of a worksheet that acts as a 
means to identify or access different sheets within a 
workbook.
	 Slide Show: Used to display the slides in a desired 
sequence.
	 SMS (Short Message Service): A popular wireless 
service that is used for sending and receiving short 
messages up to a maximum of 160 characters. The 
service is used for text messaging between cell 
phones that are on a GSM (Global System for Mobile) 
network.
	 Software: The set of instructions used to direct 
the operation of a computer, as well a documentation 
giving instructions on how to use them.
	 Social Networking: The grouping of individuals 
or organizations into specific groups.
	 Source Code: Program code written in a high level 
language.
	 Source data: Data for which the chart is prepared.
	 Spam: The disruptive unwanted messages, 
especially commercial messages posted on a computer 
network or sent as e-mail.
	 Spreadsheet: A document which helps to organize 
data in rows and columns that intersect to form cells.
	 Supercomputer: High-capacity computer with 
thousands of processors that is the fastest calculating 
device ever invented.
	 Switch: In networks, a device that filters and 
forwards packets between LAN segments.
	 Syntax: Grammatical rules and structural patterns 
governing the ordered use of appropriate words and 
symbols for issuing commands, writing code, of a 
programming language.

	 System: Collection of related components that 
interact to perform a task in order to accomplish a 
goal.
	 Systems Analysis and Design: A six-phase 
problem-solving procedure for examining an 
information system and improving it.
	 Systems Development Life Cycle (SDLC):  A 
step-by-step process that many organizations follow 
during systems analysis and design.
	 System Software: It is a set of master programs 
that keeps the computer system working. 

T

	 Task bar: The bar that contains the start button 
and appears by default at the bottom of the desktop.
	 TCP/IP: Acronym for Transmission Control 
Protocol/Internet Protocol, the suite of communications 
protocols used to connect hosts on the Internet.
	 Technology: It is the usage and knowledge of 
tools, crafts, techniques, or systems, or methods of 
organizations.
	 Telecommunication: The transmission of 
messages over significant distances for the purpose of 
communication
	 Terabyte (TB): 2 to the 40th power (1,099, 511,  
627, 776) bytes.
	 TIFF (Tagged Image File Format): It stores 
compressed files with a flexible number of bits per 
pixel.
	 TPS (Transaction Processing System): A computer-
based information system that tracks the transactions 
needed to conduct business.
	 Toolbar: A row or rows of buttons on a display 
screen that are clicked on to select various functions 
in a software application or web browser.
	 Topology: In networking, this refers to the physical 
or logical arrangement of a network.
	 Touch-sensitive Screen: A display screen which 
enables the computer to react to the touch of a finger.
	 Transistor: A semiconductor device that amplifies, 
oscillates, or switches the flow of current between two 
terminals by varying the current or voltage.
	 Trojan: A type of computer virus that is loaded 
into an unsuspecting users system via a host program 
such as a free game.
	 Turtle: A triangular shape pointer used in LOGO 
that helps in drawing figures.
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	 Twitter: A microblogging facility that allows users 
to post very short texts (maximum 140 characters) 
containing snippets of information about what they are 
doing at a given moment, news items, links to websites 
or comments on events.

U

	 UNICODE: Binary coding scheme that uses 2 
bytes (16 bits) for each character. It allows almost all 
the written languages of the world to be represented 
using a single character set.
	 Uploading: It means transmitting data from a local 
computer to a remote computer, as from your PC to a 
website you are constructing.
	 UPS (Uninterruptible Power Supply): It is a 
backup power unit that provides continuous power 
when the normal power supply is interrupted.
	 URL (Uniform Resource Locator): A protocol for 
specifying addresses on the Internet. It is an address 
that identifies a particular file on the Internet, usually 
consisting of the protocol as http, followed by the 
domain name.
	 User: Someone attached to a server or host.
	 User-friendly: Mainly used to describe software. 
Software that is easy to use and offers guidance if the 
user does silly things is described as user-friendly.
	 Utility Program: A program developed to run 
within an Operating System to perform a specific 
service.

V

	 Videoconferencing or Video Conferencing: A 
computer-based communications system that allows 
a group of computer users at different locations to 
conduct a “virtual conference” in which the participants 
can see and hear one another as if they were in the 
same room participating in a real conference.
	 Virus: A program or piece of code that is loaded 
onto your computer without your knowledge and 
runs against your wishes.

W

	 W3C (World Wide Web Consortium): An 
international non-profit organization which acts as a 
resource centre for the World Wide Web, and is active 
in setting technical standards.
	 WAN (Wide Area Network): A network in 
which computers are connected to each other over 

a long distance, using telephone lines and satellite 
communications.
	 WAV: Stands for WAVeform sound format. 
Microsoft’s format for encoding sound files.
	 Webcam: A camera connected to a computer and 
linking it to the Internet.
	 Web page or Webpage: A single, usually hypertext 
document on the World Wide Web that can incorporate 
text, graphics, sounds, etc.
	 Web server: A computer that runs specific software 
to serve web pages to the Internet.
	 Web site: A connected group of pages on the 
World Wide Web regarded as a single entity, usually 
maintained by one person or organization and 
developed to a single topic or several closely related 
topics.
	 Wizard: A utility that provides guided sequence to 
perform complex task easily and quickly.
	 Wifi: Wireless Fidelity, also known as wireless 
networking, a way of transmitting information without 
cables that is reasonably fast and is often used for 
laptop computers within a business or  school campus 
instead of a Local Area Network (LAN) that uses cable 
connections.
	 Wikis: Webpages that can be viewed and modified 
by anyone with a Web browser and Internet access.
	 Word Processor: Software that processes textual 
matter and creates organized documents.
	 Workstation: The computer attached to the 
Internet.
	 WWW (World Wide Web): Series of servers or 
computers that are interconnected through hypertext.
	 WYSIWYG: What You Say Is What You Get.

X

	 XML (eXtensible Markup Language): It is a markup 
language, not limited to Web documents.

Y

	 YouTube: A website to which we can upload our 
own video clips and view video clips uploaded by 
others: http://www.youtube.com.

Z

	 Zip Disks: The disks with a special high-quality 
magnetic coating that have a capacity of 100, 250 or 
750 megabytes.
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